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Gateway for the integration of KNX TP-1 (EIB)
devices into BACnet/IP control systems.

Models available for this gateway, with their following Order codes:

IBOX-BAC-KNX-100
Tiny model supporting connection to up to 100 internal data points.

IBOX-BAC-KNX-A
Basic model supporting connection to up to 500 internal data points.

IBOX-BAC-KNX-B
Extended model supporting connection to up to 3000 internal data points.
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1. Description
1.1 Introduction

This document describes the integration of KNX TP-1 (EIB) systems with BACnet ASHRAE
135 - 2001 Annex J - BACnet protocol compatible devices or systems using the gateway
IntesisBox BACnet/IP Server - KNX.

This document assumes that the user is familiar with KNX and BACnet/IP technology and
technical terms.

From now on, and with the aim of easy the read of this document, the words "gateway" or
“IntesisBox” are used instead of IntesisBox BACnet/IP Server - KNX. Any other use of the
word "gateway" not meaning IntesisBox BACnet/IP Server - KNX will be specifically
indicated.

The aim of this integration is to make accessible KNX system signals and resources from a
BACnet/IP based control system or device, as if it was a part of the own BACnet system and
vice-versa. For this, the gateway acts as a BACnet/IP Server device in its BACnet interface,
allowing other BACnet/IP devices to perform subscription (COV) requests, and also read and
write its internal points. From the KNX system point of view, the gateway simulates a KNX
device and acts as if it was one more device into the KNX system.

KNX == Ethernet

IntesisBox BACnet/IP Server

LinkBoxBacnet
Configuration . .
Software Only needed for configuration
Figure 1.1 Integration of KNX and BACnet/IP using IntesisBox BACnet/IP Server -
KNX gateway
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1.2 Functionality

The integration operation is as follow:

From the KNX system point of view, in the startup process of the gateway and also after a
detection of a KNX bus reset, the gateway polls the KNX signals configured to be updated in
this situation and maintain the received values in memory to be served to the BACnet
system when requested. Also listen for any KNX telegram related to the internal points
configured in it and acts accordingly to the configuration of the related point.

From the BACnet system point of view, after the startup process, the gateway listens for
any subscription (COV) request, serves any polling request or performs any writing request
of its internal points received from BACnet system. The values received from BACnhet
become available to be read (and when applicable, written) by the KNX system and vice-
versa.

If a signal has been configured as of type “T” Transmit (in the KNX part), any new value for
the signal coming from the BACnhet system is notified to the KNX system with the
corresponding telegram.

When, from the KNX system, a signal is changed (written from any other KNX device for
example), the new value is updated in the gateway's memory and, if this signal is
associated to a BACnet active subscription then the new value will be sent to the
subscripted BACnet device(s).

Also the following functionality is supported by the gateway:

For every point, in the KNX part, one main group address and different listening group
addresses can be defined. With this, from KNX, every point can be addressed not only using
its main group address but also using the other defined listening addresses for the point.

Any change in a gateway's point with the feature “T” activated (in the KNX part), will force
the transmission of this point value with the corresponding telegram to the KNX system.

When the gateway starts up, or after an KNX bus reset, all the points with the feature “U”
or "U2" activated (in the KNX part) will be forced to be read in the KNX system to update its
values in the gateway’s internal memory.

Any point with the feature “"W" activated (in the KNX part), can be written in any moment
from the KNX system.

Any point with the feature "R” activated (in the KNX part), can be read in any moment from
the KNX system.

All the mentioned features (W,R,T,U) related to the KNX interface are deeply explained in
section 5.1.2.

KNX EIS (data types) supported are: switching (1 bit), dimming (4 bit), float (16 bit),
scaling (8 bit), drive control (1 bit), priority (2 bit), float IEEE (32 bit), counter (8 bit),
counter (16 bit), counter (32 bit), ASCII char (8 bit).
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1.3 Capacity of IntesisBox

Element Tiny Basic | Extended | Notes
version |version| version

Type of BACnet Only those supporting BACnet/IP.

devices

Number of BACnet 100 500 3000 Maximum number of points that can be

points defined in the virtual BACnet device
inside the gateway.

Number of BACnet 8 8 8 Maximum number of BACnhet

subscribers subscribers accepted by the gateway.

Number of BACnhet 1000 1000 6000 Maximum number of BACnet

subscriptions subscriptions (COV) requests accepted

(COV) requests by the gateway.

KNX 500 500 3000 Maximum number of different KNX

groups group addresses that can be defined.

KNX 1000 1000 1000 Maximum number of different KNX

listening group addresses that can be defined as

addresses listening addresses, one or more of
these listening addresses can be
assigned to every point. With this,
more than one KNX group address of
the KNX system can actuate on the
same gateway's point.

There are two different models of IntesisBox BACnet/IP Server - KNX, with different
capacity every one of them.

e Tiny model supporting connection to up to 100 internal data points.
Ref.: IBOX-BAC-KNX-100.

e Basic model supporting connection to up to 500 internal data points.
Ref.: IBOX-BAC-KNX-A.

e Extended model supporting connection to up to 3000 internal data points.
Ref.: IBOX-BAC-KNX-B.
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2. Interfaces

This section gives the reader an idea on how a KNX system/installation is integrated with
IntesisBox BACnet. It is not meant to provide an in-depth explanation on how BACnhet or
KNX technology work as understanding the protocol principles is assumed throughout this
document.

The IntesisBox behaves as a regular BACnet device inside the BACnet system integrating all
the KNX devices. Note that each datapoint defined on IntesisBox will have two associated
data types:

e One data-type, related to the BACnet/IP protocol of the IntesisBox
¢ And another data-type, related to KNX side of IntesisBox

Conversions of data values from KNX to BACnet/IP data-types (and vice versa) are
internally performed at application level of IntesisBox, and keeping the highest possible
level of precision, with the restrictions of the data-type itself. Further detail on behavior and
data-types of the BACnet/IP and KNX interfaces of IntesisBox is given in the following
sections.

All configuration of IntesisBox BACnet is done using software tool LinkBoxBacnet. This tool,
covered in depth in section 5, is used to define the KNX and BACnet related parameters on
each of the datapoints defined in IntesisBox.

2.1 BACnet

The IntesisBox integrates all the KNX devices in a single BACnet device. The communication
with the other BACnet devices is done via the Ethernet port of the gateway which
implements the BACnet ASHRAE 135 - 2001 Annex J - BACnet protocol.

In addition, IntesisBox can be configured to be a BBMD (BACnet Broadcast Management
Device). See details in section 5.1.3.

The supported BACnet Objects and Building Blocks can be found in the PICS document
available on the web:

http://www.intesis.com/pdf/IntesisBox BACnet IP Server KNX PICS.pdf

Configuration of all BACnet/IP parameters of IntesisBox and their links to KNX using
LinkBoxBacnet software tool is covered in section 5.1.

2.2 KNX TP-1 (EIB)

IntesisBox BACnet/IP Server - KNX supports the KNX TP-1 physical layer, as defined in the
KNX standard. It behaves as one more device of the KNX system, with the same
configuration and functional characteristics as other KNX devices.

KNX TP-1 (EIB) bus provides a 30V DC current, which can even directly power certain low-
consumption KNX devices. IntesisBox does not drain any significant current from the KNX
bus - it has a separate own power supply. Another important electrical aspect is that the
KNX TP-1 (EIB) port of IntesisBox is optically isolated (~2500Vrms AC) from all its other
ports (EIA232, EIA485, Ethernet) and power supply.

At logical level, all KNX devices feature an interface of communication objects, by which
their functionality is abstracted. As a basic example, a KNX interface of an AC indoor unit
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would typically consist of an interface of datapoints such as “On/Off”, "“Setpoint
temperature”, “"Operating mode”, etc.

Associations between communication objects from different KNX devices are actually done
by means of so-called group addresses.

KNX telegrams within a working KNX installation are always addressed to a certain KNX
group address. Typically, whenever a communication object on a KNX device changes its
value, the new value is updated to the bus, by sending a “write” telegram addressed to its
associated group address. The rest of KNX devices in the installation that have a
communication object associated to this group address will act accordingly on reception of
the new value.

Other operations are possible. KNX devices can also decide to read the current value of the
communication objects, by sending a “read” telegram to a certain group address (previously
known to be associated to the targeted comm. object). This operation is performed by many
devices on bus start-up or recovery - in this way, the device gets the latest value of the
group addresses it has associated right from its start-up.

Each datapoint defined in IntesisBox KNX configuration needs to have at least a single KNX
group address associated with it. This group address will be used either for sending updates
to KNX of the datapoint value (that have been generated on the other BACnet/IP interface
of the IntesisBox), or receiving updates from KNX of the datapoint value (that will be
propagated to the BACnet/IP side in this case)

From the point of view of KNX functionality, each datapoint of IntesisBox can hold following
group address associations:

e A single KNX group address with which update/write telegrams will be sent,
whenever the datapoint changes (as a result of a change coming from the other
interface of IntesisBox, BACnet/IP in this case).

e One or more KNX group addresses from which this datapoint of IntesisBox will be
updated/written from the KNX installation (resulting in a change to the other side of
IntesisBox, BACnet/IP in this case).

e A single KNX group address from which IntesisBox will read the object value on KNX
bus recovery / IntesisBox start-up.

Behavior of IntesisBox’ datapoints with regard to their associated group addresses is
defined by means of flags (R, W, T, U and U2), explained in section 5.1.2.

Additional to the binding aspect commented above, it is also important to notice that each
KNX communication object has a defined EIS type. The EIS type of a communication object
defines the bit length and coding of the data it represents. Communication objects
associated by means of a group address need to match the same EIS type, in order to
communicate consistently.

So, at configuration time it is required that for each datapoint configured on IntesisBox an
EIS type is defined. Datapoints on IntesisBox BACnet support the following EIS-types:

EIS1 - Switching (1bit raw)

EIS2 - Dimming (4bit raw)

EIS5 - Value (16bit - floating type)

EIS6 - Scaling (8bit - scaled 0%-100% in values 0-255)
EIS7 - Drive Control (1bit raw)

EIS8 - Priority (2bit raw)

EIS9 - IEEE 754 float (32bit - floating type)

EIS10 - 16bit Counter (16bit raw)
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e EIS11 - 32bit Counter (32bit raw)
e EIS13 - ASCII char (8bit raw)
e EIS14 - 8bit Counter (8bit raw)

ETS3 or ETS4 software tools are not used to configure IntesisBox. Though, it’s typical that
the choice of which KNX group addresses to use is restricted or defined by an ETS-based
project. If that's the case, the KNX installer/integrator needs to provide the set of group
addresses prior to doing the configuration of datapoints in LinkBoxBacnet.

Also, a dummy ETS application is provided by Intesis Software (section 6), which can be
imported into ETS. This application is nor downloadable into IntesisBox BACnet neither
usable for IntesisBox configuration. Rather, it poses as a means of having a device in the
ETS project representing the IntesisBox BACnet and its own datapoints/communication
objects, and to which group addresses are associated.
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3. Quick Setup

1. Install LinkBoxBacnet. Details in section 5

2. Install IntesisBox in the desired installation site (DIN rail mounting inside a metallic
industrial cabinet connected to ground is recommended).

3. Power up and connect the communication cables. Details in section 3.

4. Open LinkBoxBacnet, open a project or create a new one. Details in section 5.
5. Connect to the IntesisBox (details in section 5).

6. (optional) Configure the IntesisBox. Details in section 5.1

7. Check if there is communication in both BACnet and KNX buses (section 5)

8. The IntesisBox is ready to be used in your system.
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4. Connection

The device uses a standard enclosure allowing DIN EN60715 TH35 rail mounting. Its plastic
meets standard PC UL 94 VO.

Power BACnet/IP KNX bus
(Ethernet)
KNX button
% (Reserved for future use)

O = = 101 0o

mlele ETH @ EACT = Tx 1} @I + -
ON 10 Base-T = LNK = Rx PROG

-+ p— BUS PROG
CMN 24Vac —_—
——KNX TP-1 (EIB
—— BACnet/IP (EIB)
Area .
9-30 Vdc = ® Y
Max. 125mA |ntES|SBOX —lc-:'ne :
. . om .
::affnmA www.intesis.com
50-60Hz
IBOX-BAC-KNX lm‘ X
= PC
E = G Console
Serial Port
(Not used)

PC (LinkBoxBacnet)

Figure 4.1 Device connection diagram
Ensure proper space for all connectors when mounted.
The items supplied by Intesis Software for this integration are:
o IntesisBox BACnet/IP Server - KNX hardware
e Console cable. Standard DBO9F-DB9M cable 1.8 meter long.

e Installation sheet, containing a link to the LinkBoxBacnet software and this
manual.

4.1 Power device

The first step to perform is to power up the device. To do so a power supply working with
any of the voltage range allowed is needed (check section 6). Once connected the ON led
(Figure 4.1) will turn on.

WARNING! In order to avoid earth loops that can damage the gateway and/or any other
equipment connected to it, we strongly recommend:
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e The use of DC power supplies, floating or with the negative terminal connected to
earth. Never use a DC power supply with the positive terminal connected
to earth.

e The use of AC power supplies only if they are floating and not powering any other
device.

4.2 Connect to KNX

Connect + and - terminals of the KNX bus to the IntesisBox KNX connector (Figure 4.1).
The polarity is important. Once connected correctly the KNX Tx led (Figure 4.1) will start
blinking. If that doesn’t happen check that the cable is connected properly.

How to check if there is communication with the KNX bus is explained in the LinkBoxBacnet
Manual (section 5).

4.3 Connect to BACnet

Connect the communication cable coming from the network hub or switch to the ETH port
(Figure 4.1) of IntesisBox. The cable to be used depends on where the IntesisBox is being
connected:

e Connecting directly to a BACnet/IP device: crossover Ethernet UTP/FTP CAT5 cable

e Connecting to a hub or switch of the LAN of the building: a straight Ethernet UTP/FTP
CATS5 cable

In case there is no response from the BACnet devices to the frames sent by IntesisBox,
check that they are operative and reachable from the network connection used by
IntesisBox. Check the IntesisBox Ethernet interface sending Pings to its IP address using a
PC connected to the same Ethernet network.

4.4 Connect to PC (LinkBoxBacnet)

This action allows the user to have access to configuration and monitoring of the device
(more information can be found in the LinkBoxBacnet User Manual [section5]).Two methods
to connect to the PC can be used:

e Ethernet: Using the ETH port (Figure 4.1) of IntesisBox. How to check connectivity is
explained in section 4.3.

e Serial cable: To connect the device to the PC the serial cable supplied should be
plugged to the PC console port (Figure 4.1).
The cable is a RS-232 straight cable and its pinout is at explained in Table 4.1.

IntesisBox PC
DB9 M RS-232 (Straight) DBY9 F
X 2 > 2 RX
RX 3 |« 3 TX
GND 5 |« > 5 GND

Table 4.1 Configuration serial cable pinout

© Intesis Software S.L. - All rights reserved URL http://www.intesis.com 13/ 31

L
This information is subject to change without notice I n tes Is L Email info@intesis.com
® software

IntesisBox” is a registered trademark of Intesis Software SL tel +34 938047134



IntesisBox® BACnet/IP Server - KNX User’s Manual r18 eng

5. LinkBoxBacnet. Configuration & monitoring of IntesisBox BACnet
series

How to install and use the LinkBoxBacnet is explained in its Manual. It can be found in the
installation folder (if the Software is already installed) or it can be downloaded from the link
that can be found in the installation sheet supplied with the IntesisBox.

In this section only the specific project configuration for IntesisBox BACnet/IP Server - KNX
is going to be explained.

The External Protocol in this IntesisBox is KNX

5.1 Project configuration

To configure the integration connection parameters, and the points list, click on Config in
the Button Bar (Figure 5.1). The KNX Configuration window will be opened. For integrations
with a large number of points an alternative CSV based configuration method is explained in
in the LinkBoxBacnet Manual.

LinkBoxBacnet V.1.1.33
File Options Windows 7

g 2 &

Projects Config | Connect COM7 Signals BACnet  KNX

| IntesisBox Communication Console EI@

|| j wF V¥ Active W &utoScral [~ Logthafile

Figure 5.1 Menu and Button Bar in LinkBoxBacnet

5.1.1 Connection configuration

Two subsets of information are configured using this window, the BACnet/IP parameters of
the IntesisBox, and the parameters of the KNX interface.
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& Configuration KNX - Max Points:500 GroupsKNX:500 List. AddressKN::1000 = (=] ]

'} Signals | BBMD |
Bacnet / IP KM= BAChet Binary object tests

192168.100.246 |P Physical Address | 15.15.255 Active Active ext

295.255.255.0 Nettask [@ Force updats after an KN bus Inactive Inacive text
reset.
Gateway

|_4 Delay for update after bus reset.
47808 Port Bacnet

Device
246

Device Mame

KM Gateway

Wersion
A-Basic hd

Firmware Version

. 4.1, [Units) -

Connection configuration

Save Exit

Figure 5.2 Configuration: Connection Tab

BACnet/IP interface configuration parameters:

Bacnet / IP

192168100246 |P

285.256.255.0 MetMazk

3 ateway

47308 Part Bachet

Device
245

Device Mame
|KN>< G atesay

Wersion
A-Baszic -

Firrnwware Wersion
41,5 (Unis] |

Figure 5.3 BACnet/IP interface Configuration

e IP: Enter the IP address for the gateway (supplied by the network administrator).

e NetMask: Enter the IP NetMask for the gateway (supplied by the network
administrator).

e Gateway: Enter the Default Gateway address (router address) in case the gateway
(IntesisBox) is in a different sub network than other BACnet devices (supplied by the
network administrator). Leave blank if there is no need of router address.

e BACnet Port: Enter the BACnet port number used by the gateway (by default
47808, which is BACO).
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e Device: Enter the BACnet device number for the gateway (must be unique inside the
BACnet system).

e Device Name: Select the BACnet device nhame for the gateway (by default "KNX
Gateway"). This name will be collected by BACnet browsers among others.

¢ Version: Select the gateway model used: tiny,basic or extended. You can check the
gateway model in the identification given by the device when it connects to
LinkBoxBacnet, it appears in the IntesisBox Communication Console window once
connected to the gateway. You can also send the “INFO?” command through
IntesisBox Communication Console in order to check it.

IntesisBox_Bacnet_ KNX-100_V4x.x.x... - Tiny model
IntesisBox_Bacnet_KNX-A_V4x.X.X... - Basic model
IntesisBox_Bacnet_ KNX-B_V4x.Xx.X... - Extended model

e Firmware Version: Select the gateway firmware version. Firmware version appears
in the same string as gateway’s model:

IntesisBox_Bacnet_ KNX-100_V4x.x.x...

KNX interface configuration parameters:

KM=

Physical Addresz | 15.15.255

v Force update after an KM bus
reset,

|_4 Delay for update after bus reset.

Figure 5.4 KNX interface Configuration
e Physical Address: Enter the KNX physical address for the gateway.
e Force update: Check this if you want the gateway to update the signals configured
as “U” or “U2” after a KNX bus reset. Details about configuring signals as “U” and

“U2” in section 5.1.2.

¢ Delay: Delay (in seconds), after gateway start-up or bus reset detection, to start the
update process.

BACnet Binary objects texts

BAChet Binary object texts

|fictive Active test

|Inactive Inacive text

Figure 5.5 BACnet Binary object texts
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o Active text: text for the “Active_Text” property of all the Binary objects.

o Inactive text: text for the “Inactive_Text” property of all the Binary objects.

5.1.2 Signa

Is configuration

Select the Signals tab (Figure 5.6) to configure the signals list (the IntesisBox internal
points). More information about the meaning of the columns can be found in the tables

below.

Every row in the grid corresponds to a signal (point). Signals (rows in the grid) can be
added or deleted selecting the desired row and clicking Add or Delete buttons. Multiple
consecutive rows can be deleted too.

3

# D ata type [ Description EIS Group Ligtening addre:| B [ | T | U |Bac.Mame Bac.Ty| Bac.ID| Active | Units

1| 0-Error co| Error com, KN BUS_KMNx_ERR_COM 3Bl 0/ 14es

2[1-Data | Test object BI 1 - Switching [1 ki)  1/041 w U | Test abject BI 3Bl 1 1es

3[1-Data | Testobject BO 1 - Switching [1 bit)  1/0/5 Riw T Test object BO 4.B0 0 14es

4{1-Data Test object BY 1 - Switching [1 ki) | 1/0/0 wT Test object BY 5-BY 0|1-¥es

5(1-Data Test object Al 5 - Float [2 bytes] /0413 1/014 W U2 Test object &l 0-a] 0|1-Yes | degrees_Celsius [B2)
E[1-Data Test object AQ 5 - Float [2 bytes] 1/043 R T Test object A0 1-80 0/1-Yes | no_units (95)
Fl1-Data Test object AY 5 - Float [2 bytes] 1/042 W Test object A4 0/1¥es: | no_units (95)

Integration signals confi

iguration

[ Auto Bac.Name T Jl Add

Dielete Save Exit

Figure 5.6 Signal list

# (Signal’s number)
Description | Enumeration of the rows in the grid (signals). If clicked on them the whole
row will be selected (to be used to delete/add rows
Restrictions | Cannot be edited
Data type
Description | Select the type of signal
Values e Communication Error: indicate to the BACnet side a communication
error within the KNX system
e Data: for normal signals
Restrictions | Cannot be edited
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Description

Description | Signal’s description (optional). Used to describe the signal at user level. This
description entered here is included into the BACnet's Description property
for the point and thus it will be collected by any BACnet explorer.

Restrictions | 30 characters maximum

Comments If the description gives some good information about the physical location of
the KNX point related, it may help during the gateway's integration phase
into the BACnet system.

EIS

Description | KNX data type (Data point) to encode the signal’s value. It will depend on
the BACnhet type of signal associated to it in every case .Edit using the
mouse right-button-click pop-up menu available on the column

Values e Switching (1 bit)
e Dimming (4 bit)

e Float (16 bit)

e Scaling (8 bit)

e Drive control (1 bit)
e Priority (2 bit)

e Float IEEE (32 bit)
e Counter (8 bit)

e Counter (16 bit)

e Counter (32 bit)

e ASCII char (8 bit)

e Counter (8 bit)

Restrictions | Only the EIS defined in values are allowed.
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Group

Description

Main KNX group address for the signal. Flags R,W,T,U explained below will
only apply for this main KNX group address, not for listening addresses.

Values

Group address in one of the following formats:
e P/I/S
e P/S
e Single level (value 1 to 32767)

Restrictions

Duplicated groups are not allowed

Empty groups are allowed, but only if they have just W activated and one or
more listening addresses.

Listening addresses

Description

KNX group addresses that will be listened by IntesisBox for this signal. If
IntesisBox receives a KNX telegram whose destination is one of these
listening addresses, the telegram will be taken into account and the
corresponding action will be performed on this signal.

Values

Group addresses in one of the following formats:
e P/I/S
e P/S
¢ Single level (value 1 to 32767)

More than one address can be entered, comma separated.

Restrictions

It is not allowed a listening address that is the same as the sending group
(circular reference).

Listening addresses are not allowed if the flag W is not activated. Without W
activated, the listening addresses would not work.

R

Description

Indicates if this signal is allowed to be read from KNX system.

Values

e “R”": flag activated

¢ Blank: flag not activated

Restrictions

Can't be active when the BACnet signal are AI, BI or MI
Needs the T flag active and therefore the software activates it automatically

Can’t be simultaneously active with flag U and it is disabled if that flag is
activated. It has no restriction with U2
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w

Description

Indicates if this signal is allowed to be written from KNX system.

Values e “W": flag activated
¢ Blank: flag not activated
Comments If it is not active, no write on the group address neither on the listening

addresses could be done from KNX

KNX Update telegrams (responses to Read) are handled in the same way as
Write telegrams, in all cases.

T

Description

Indicates if this signal will generate a telegram sending to the KNX system
following a change of the signal’s value, that is to say, any change of value
of this signal in BACnet side will be transmitted to the KNX system if this flag
is activated.

Values

e "T": flag activated

¢ Blank: flag not activated

Restrictions

Can't be active when the BACnet signal are AI, BI or MI

u

Description

Indicates if this signal will be updated (sending read requests) whenever
IntesisBox starts up or after a KNX bus reset.

Values

e "U”: flag activated for the main KNX group address. A read of the
main KNX group address will be performed in the KNX system for the
update.

e “U2": flag activated for the first listening address defined. A read of
the first listening address defined for the point will be performed in
the KNX system for the update).

e Blank: flag not activated

Restrictions

Needs the W flag active and therefore the software activates it automatically

When “U” is selected it disables the R flag.

Comments

DO NOT BE CONFUSED: Philosophy of IntesisBox point's U flag is not
the same as KNX device's U flag. In KNX devices, U flag means that
the point's value will be updated whenever a write telegram for the
group address is received by the device.
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Bac.Name

Description

BACnet object name for the signal. This name is included into the BACnet's
Object_name property for the point and it will be collected by any BACnet
explorer. From here a BACnet explorer or supervisor can get the KNX group.
That may help during the gateway's integration phase into the BACnet
system.

Values Same as description
Following the format: TT_AA_LL_CCC D..D where
e TT = BACnet object type abbreviation (see below).
e AA = First part of the KNX group address defined for the point.
e LL = Second part of the KNX group address defined for the point.
e CCC = Last part of the KNX group address defined for the point.
e D..D = Point's description entered in column Description.
Comments It changes from one format to the other when changing the value of auto

Bac Name checkbox

Bac.Type

Description

BACnet object name for the signal. This name is included into the BACnet's
Object_name property for the point and it will be collected by any BACnet
explorer. From here a BACnet explorer or supervisor can get the KNX group.
That may help during the gateway's integration phase into the BACnet
system.

Values

e Al = Analog Input.

e AO = Analog Output.

e AV = Analog Value.

e DI = Digital Input.

e DO = Digital Output.

e DV = Digital Value.

e MI = Multistate Input.

e MO = Multistate Output.

e MV = Multistate Value.

Restrictions

When the type is Al, BI or MI the flags R and T are not selectable

Comments

Edit using the mouse right-button-click pop-up menu
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Bac.ID

Description

BACnet object instance number for the point. It can be manually entered by
the user or can be automatically assigned by LinkBoxBacnet when saving the
configuration (section 5.1.3)

Restrictions

All the object instance numbers for objects of the same type must be
different

Comments

It is recommended to let LinkBoxBacnet assign automatically object instance
numbers for the points

Active

Description

Indicates if the signal is active or not for the integration

Values

e 0: Not active

e 1: Active

Units

Description

Select a type for the BACnet Units

Values

e Area: Square Meters, Square Feet, etc.

e Electrical: Amperes, Ohms, etc.

e Light: Lumens, Luxes, etc.

e Mass: Kilograms, Pounds Mass, Tons.

e Pressure: Bars, Pascals, etc

e Time: Years, Months, etc.

e Temperature: Degrees Celsius, Degrees Kelvin, etc.

e FEtc.

Restrictions

Only for the analog objects

Comments

Edit using the mouse right-button-click pop-up menu

Auto Bac. Name

Description

Checkbox that controls the Bac. Name format

Values e Checked: special format (Check Bac. Name table for details)
¢ Not checked: Bac. Name = Description
Comments | Check Bac. Name table for details
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(Import from ETS)

Description

Used to import group addresses from ETS files

Values

This button let you select the different import methods (Explained in section
6.2)

e Import group Address ... (CSV format: 1/1 tab separated)

e Import ESF files ...

™

Description

Buttons to move the selected row (or rows) up or down inside the grid. To
move up or down inside the grid a single row or a group of consecutive
rows, just select the row or rows using the left button of the mouse and
push the desired up or down button.

Comments

This can be done also using the key combinations ALT+arrow up or
ALT+arrow down instead of up or down buttons

Add

Description

Button that adds a row under the selected one.

Delete

Description

Buttons to delete the selected row (or rows).

Save

Description

Save the configuration (details in section 5.1.3)

Exit

Description

Exits the configuration window (details in section 5.1.3)

5.1.3 BBMD configuration

BBMD functionality is available from firmware version V.41.1.28 and only for versions

V.41.1.x.

When BBMD functionality is enabled, IntesisBox also provides support for Foreign BACnet
Devices with a maximum of 10 devices.
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& Configuration KNX - Max Points:500 GroupsKNX:500 List. AddressKN::1000 = (=] ]

[# Enable BEMD Readfomfie | Witetafle |

EDT
BBMD | Pl Pt Mask | | BEMD-1 Mame
BBMD1 192188100246 47R0B 2952256255 Noycaiinag e
BBMD-2 192168.015 47808  255.255.255.255 =
[l BEMD-2 19216820015 47808 255.256.255.0 47808 ot UDP
] BEMD-4 47808 285285255255 | 255 255255.255 Mask to apph
[C1EEMDS 47808 255255255255
[ BBMD-6 47808 255 255 255 255
[ BBMD-7 47808 255 255 255 255
[1EEMD-E 47808 255,255,255, 255

BBMD configuration, available from P version V.41.1.28 (only for . 41.1
configuration, available from VEISIon [only far Bl Save Edil

Figure 5.7 BBMD configuration

e Enable BBMD: Activating this option, besides its normal operation, the IntesisBox
will also behave as a BBMD.

Take into account that when BBMD functionality is enabled, the Gateway address in
Connection tab is supposed to be configured so the IntesisBox can forward BACnet
telegrams to external networks.

When this option is disabled, the rest of elements in the tab will not be visible as
they will have no effect on the IntesisBox.

Remember to press the Save button and send new configuration file to the
IntesisBox in order to apply the changes.

e BDT: The Broadcast Distribution Table can be defined either through LinkBoxBacnet
or using the BVLL Write-Broadcast-Distribution-Table BACnet message. Last BDT
written to the IntesisBox will be saved and used from that moment, no matter the
way it is been written.

Maximum number of BDT entries is 8, entries can be activated or deactivated by
clicking its related check box. Select a BDT entry in order to change its parameters.

If IntesisBox’s own BDT entry is not configured, the whole BDT will be considered
incorrect and will not be accepted.

¢ Name: Identifying name of the related BBMD. This name is optional and it will only
be used in LinkBoxBacnet’s BDT.

e IP: IP address of the related BBMD. Default value is no IP address (empty), but if
the BDT entry is activated an IP address must be defined, otherwise the BDT will be
considered invalid.

e Port UDP: Port UPD of the related BBMD. Default value is "47808".

e Mask to apply: Broadcast distribution mask of the related BBMD. Default value is
"255.255.255.255",
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e Read from file: BDT will be overwritten by the last BDT saved in LinkBoxBacnet file
“KNX.ini"”.

e Write to file: BDT will be saved in LinkBoxBacnet file "KNX.ini”.
e Read from GW: BDT will be overwritten by the BDT currently used by IntesisBox.
This button will be disabled if IntesisBox is not connected to LinkBoxBacnet.

e Write to GW: BDT will be written to the IntesisBox and from that moment
Intesisbox will use this BDT for BBMD functionality. Bear in mind that IntesisBox’s
BDT can be overwritten by BACnet means.

This button will be disabled if IntesisBox is not connected to LinkBoxBacnet

5.1.4 Saving the configuration

When the configuration of the project is finished follow the next steps:

1. Click the button Save. Once accepted the pop-up message, that will save the project
in the folder on hard disk (more information in LinkBoxBacnet Manual).

2. You will be prompted to generate the configuration file to be sent to the gateway,

a. If YES is selected, the binary file (KNX.LBOX) containing the configuration for
the gateway will be generated and saved also into the project folder.

b. If NO is selected the binary file needs to be created before following the next
steps. To do so open the Configuration window (section 5.1) and restart from
step 1

3. A pop-up message will show up asking if you want to preserve the Object
instance numbers. BE CAREFUL using this feature.

a. If NO is selected all the object instance numbers for the points will be
automatically reconstructed and thus loosing previous instance numbers, if
defined. ONLY USE this option for a brand new configuration not
previously running in the gateway and therefore not yet integrated into the
BACnet system

b. Select Yes for configurations previously running in the gateway and
already integrated into the BACnet system that had been extended with
a few more points that must respect the previously defined object
instance numbers. All the points with object instance numbers defined will
be respected. LinkBoxBacnet will automatically assign object instance
numbers to ones without it.

4. As the final step, a pop-up message will ask if you want to see the BACnet points list
report, If you select Yes, a text file called KNX- BACNET OBJECT LIST.TXT will be
generated and saved into the project folder containing a report of all the point's
BACnet information (for informative purposes at user level). The file will be also
opened in the notepad, it looks like this:

Objldent ObjType OInst ObjName

12582912 3-BI 0000 BUS_KNX_ERR_COM

00000000 0-AI 0000 AI_01_0_013 Test object AI
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04194304
08388608
12582913
16777216
20971520
54525952
58720256
79691776

1-AO
2-AV
3-BI
4-BO
5-BV
13-MI
14-MO
19-MV

0000
0000
0001
0000
0000
0000
0000
0000

AO_01_0_003 Test object AO
AV_01_0_002 Test object AV
BI_01_0_001 Test object BI
BO_01_0_005 Test object BO
BV_01_0_000 Test object BV
MI_01_0_007 Test object MI
MO_01_0_008 Test object MO
MV_01_0_009 Test object MV

5. Once in the configuration window again, click on exit. The configuration is ready to
be sent to the IntesisBox (check LinkBoxBacnet Manual)

The configuration cannot be received from the gateway to LinkBoxBacnet, it can

only be sent.
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6. IntesisBox® and ETS
6.1 Integration of IntesisBox® in ETS

As explained the IntesisBox® is configured with the LinkBoxBacnet but in some projects it
might be needed to integrate the gateway in the ETS project, for example to allow the line
couplers have a correct configuration of their filter tables. To do so a Dummy device can be
used in ETS to simulate the IntesisBox and associate also to this dummy device all group
addresses used in IntesisBox

In http://www.intesis.com/down/eib/Dummy Intesis.zip an ETS project containing a
Dummy device can be downloaded for this purpose. To use it with your ETS project follow
these steps:

1) Import the pr3/pr5 file in ETS and follow the instructions

e ETS3: menu File >Import.
ETS4: Projects >Import projects

2) Open the project named Dummy Intesis.

3) In this Dummy Intesis project, in topology tree, you will find the device “Dummy
Intesis”. Select this device (click on it) and copy it (menu Edit>Copy)

4) Open your target project, select the desired line and paste the device there (menu
Edit > Paste).

Once that is done the group addresses can be configured. To do so the same addresses
configured in the LinkBoxBacnet need to be written in the right data type.
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6.2 Import ETS files to LinkBoxBacnet

Group addresses (CSV format: 1/1 tab separated) and Esf files can be imported from ETS to
LinkBoxBacnet. This allows the integration of the ETS group addresses in your IntesisBox.
How to access to this functionality is explained in section 5.1.2. Both importation methods
open a new window (Figure 6.1). The only difference between them is the information
contained in the file and therefore the values that are imported in the LinkBoxBacnet
project.

o Import KNX Group Addres files @
Select the csv file to import: Select the group addresses to import:
|Q o [05] ﬂ GP name | 55 name | GA hame | Group Add |
<<Impont2.cevs>
cA
%Usars ME-AC ON/OFF 0/on
Hlgual ME-AC MODE BYTE vz
{23 Deskiop ME-AC SET TEMP 0/0/3
ME-AC AR TEMP 0/0/4
ME-AC FAM 0/0/5
ME-AC WANE 0/0/e
ME-AC TEXTOMODO 0/047
ME-AC TEXTOFAN 0/0/8
ImEom o ME-4C TEXTOVANE 0/0/9
I fter import, delete from the list the items selected j j
1 - Switching 1 bit) | Select the EIS type to assign Flags: R[T W Thw U™
BBV | Select the BAChet Object type ta assian
To compasite the object description [max. 30 chars), use:
[ charactersfiom GP |3 cheracters riom G5 [10 characters from G +| separstor
Sample
¥ Add only the nat existing group address Save settings
I For existing group address, update the EIS and BACnet ype -
Load Fomnat ETS: 171 ftab) & "ows O ¥ For existing group address, update the description Import Exit

Figure 6.1 Import ETS files window

To Load the file with the group addresses use the File explorer (Figure 6.2). Select the
desired file and click on “Load”. The file is going to be imported and showed in the File
content section (Figure 6.3)

Select the csv file to impart;

Er5] ]

A
Y Users
Slgual

3 Desktop

\mEmH sy

Load FomatETS: 1/1 [bab) @ =cvs (0 5%

Figure 6.2 File explorer
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Once the file has been loaded the importation can be done. To do so Select the desired
lines, configure the parameters (details in the following lines) and click on “Import”. A pop-
up message with the summary of the importation shows up once it’s been done.

Select the group addresses to import:

GF name | G5 name GA name ‘ Group Add
<<Import2.caws s
ME-&C OMAOFF 0/041
ME-&C MODE BYTE 0/0/2
ME-AC SET TEMP 0/0/3
ME-&C AlR TEMP 0/0/4
|Z| ME-4C FéM 0/0/5
ME-&C WANE 0/0/%
ME-AC TEXTOMODO 0047
ME-&C TEXTOFAN 0/0/8
ME-&C TEXTOVAMNE 0/0/4
E I¥ After impart, delete fram the list the items selected j j

1 - Switching [1 hit] + | Select the EIS type to azsign Flagz: R Wh ThWw U™
BBy | Select the BAChet Object type ta assign

To composite the object description [max. 30 chars), use:

E ’9_ characters from GP ’9_ characters from GS

Sample:

10 characters from G | separator

n ¥ Add orly the not existing group address Save seftings
E I For existing group address, update the EIS and BAChet type
ﬂ I¥ For existing group address, update the description Import Exit

Figure 6.3 File contents and Group addresses selection

[1] File information. The information can be sorted by columns (clicking on
the header).

[2] Once a group address its been imported it is not showed anymore
(unless the file is reloaded)

+ - Select/deselect all the group addresses

EIS type
Same functionality and restrictions as described in the corresponding

R, W, T, U

table in section 5.1.2

Bacnet Object

[3]

Number of characters from each string (GP, GS and GA names) that are
going to compose the object description

[4] If ticked, it prevents to import already existing addresses.

[5] If ticked, when a group address already exist it updates its EIS and
Bacnet type.

[6] If ticked, when a group address already exist it updates the its

description

Save settings

Save the current settings (file path, import parameters ...) for future

imports (only for the working project).

Import Transfer the selected rows (with the defined parameters) to the
LinkBoxBacnet project.
Exit Closes the window.
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7. Mechanical & electrical characteristics

Plastic, type PC (UL 94 V-0).

Dimensions: 107mm X 105mm x 58mm.

Color Light Grey. RAL 7035.

9 to 30Vdc +/-10%, Max.: 125mA.

24Vac +/-10% 50-60Hz, Max.: 127mA

Power Must use a NEC Class 2 or Limited Power Source (LPS) and SELV
rated power supply.

Plug-in terminal block for power connection (2 poles).

Per terminal: solid wires or stranded wires (twisted or with ferrule)
1 core: 0.5mm?2... 2.5mm?

2 cores: 0.5mm?Z... 1.5mm?

3 cores: not permitted

Enclosure

Terminal wiring (for
power supply and
low-voltage signals)

Mountin Wall.
9 DIN rail EN60715 TH35.
BACnet/IP port 1 x Ethernet 10Base-T (RJ45).
KNX port 1 x KNX TP-1 (EIB) port opto-isolated. Plug-in terminal block (2
poles). TNV-1
1 x Power.

2 x KNX port activity (Tx, Rx).

2 x Ethernet port link and activity (LNK, ACT).
1 x KNX programming/bus."

Push buttons 1 x KNX programming.*

Console port EIA232. DB9 female connector (DCE). SELV
Via console port.2

Via Ethernet

Firmware Allows upgrades via console port.

LED indicators

Configuration

Operational 0°C to +70°C

temperature

Operational humidity | 5% to 95%, non condensing
Protection IP20 (IEC60529).

RoHS conformity Compliant with RoHS directive (2002/95/CE).

CE conformity to EMC directive (2004/108/EC) and Low-voltage
directive (2006/95/EC)

EN 61000-6-2, EN 61000-6-3,EN 60950-1, EN 50491-3

Norms and
standards

Not operational for the moment. Reserved for future use.

Standard cable DB9male-DB9female 1,8 meters long is supplied with the device for connection to a PC COM port for
configuring and monitoring the device. The configuration software, compatible with Windows® operating systems, is also
supplied.
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8. Dimensions

Ethernet port
+ Power

58 mm Console

Free space recommended to install the device into a cabinet (wall or DIN rail mounting),
with space enough for external connections:

100 mm

~
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